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GETTING STARTED

Have you ever looked at some gadget and wondered
how it really worked? Maybe it was a remote control
boat, the system that controls an elevator, a vending
machine, or an electronic toy? Or have you wanted

to create your own robot or electronic signals for a model railroad, or per-
haps you’d like to capture and analyze weather data over time? Where and
how do you start?

The Arduino board (shown in Figure 1-1) can help you find some of
the answers to the mysteries of electronics in a hands-on way. The original
creation of Massimo Banzi and David Cuartielles, the Arduino system offers
an inexpensive way to build interactive projects, such as remote-controlled
robots, GPS tracking systems, and electronic games.

The Arduino project has grown exponentially since its introduction
in 2005. It’s now a thriving industry, supported by a community of people
united with the common bond of creating something new. You'll find both
individuals and groups, ranging from interest groups and clubs to local
hackerspaces and educational institutions, all interested in toying with
the Arduino.
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Figure 1-1: The Arduino board

To get a sense of the variety of Arduino projects in the wild, you can
simply search the Internet. You’ll find a list of groups offering introductory
programs and courses with like-minded, creative people.

The Possibilities Are Endless

A quick scan through this book will show you that you can use the Arduino
to do something as simple as blinking a small light, or even something
more complicated, such as interacting with a cellular phone—and many
different things in between.

For example, have a look at Philip Lindsay’s device, shown in Figure 1-2.
It can receive text messages from cellular phones and display them on a
large sign for use in dance halls. This device uses an Arduino board and a
cellular phone shield to receive text messages from other phones (similar
to Project 65). The text message is sent to a pair of large, inexpensive dot-
matrix displays for everyone to see.

Figure 1-2: SMS (short message service) text marquee
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You can purchase large display boards that are easy to interface
with an Arduino, so you don’t have to make your own display from
scratch. (For more information, visit http://www.labradoc.com/i/follower/
p/project-sms-text-scroller.)

How about creating a unique marriage proposal? Tyler Cooper wanted
an original way to propose to his girlfriend, so he built what he calls a
“reverse geocache box”—a small box that contained an engagement ring, as
shown in Figure 1-3. When the box was taken to a certain area (measured
by the internal GPS), it unlocked to reveal a romantic message and the
ring. You can easily reproduce this device using an Arduino board, a GPS
receiver, and an LCD module (as used in Chapter 13), with a small servo
motor that acts as a latch to keep the box closed until it’s in the correct
location. The code required to create this is quite simple—something you
could create in a few hours. The most time-consuming part is choosing the
appropriate box in which to enclose the system. (For more information,
visit http://learn.adafruit.com/reverse-geocache-engagement-box/.)

Figure 1-3: Marriage proposal via Arduino

Here’s another example. Kurt Schulz was interested in monitoring
the battery charge level of his moped. However, after realizing how simple
it is to work with Arduino, his project morphed into what he calls the
“Scooterputer”: a complete moped management system. The Scooterputer
can measure the battery voltage, plus it can display the speed, distance
traveled, tilt angle, temperature, time, date, GPS position, and more. It also
contains a cellular phone shield that can be controlled remotely, allow-
ing remote tracking of the moped and engine shutdown in case it’s stolen.
The entire system can be controlled with a small touchscreen, shown in

Getting Started
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Figure 1-4. Each feature can be considered a simple building block, and
anyone could create a similar system in a couple of weekends. (See http://
www.janspace.com/b2evolution/ardwino.php/2010/06/26/scooterputer/.)

Figure 1-4: The Scooterputer display (courtesy of Kurt Schulz)

Then there’s John Sarik, who enjoys the popular Sudoku math puzzles;
he also likes working with Nixie numeric display tubes. With those two
drivers in mind, John created a huge 81-digit Sudoku game computer!
The user can play a full 9-by-9 game, with the Arduino in control of the
digits and checking for valid entries. Although this project might be consid-
ered a more advanced type, it is certainly achievable and the electronics are
not complex. The device is quite large and looks great mounted on a wall,
as shown in Figure 1-5. (See http://trashbearlabs.wordpress.com/2010/07/09/
nixie-sudoku/.)

The team at Oomlout even used the Arduino to create a TwypeWriter.
They fitted an Arduino board with an Ethernet shield interface connected
to the Internet, which searches Twitter for particular keywords. When a
keyword is found, the tweet is sent to an electric typewriter for printing. The
Arduino board is connected to the typewriter’s keyboard circuit, which
allows it to emulate a real person typing, as shown in Figure 1-6. (See
hitp://oomlout.co.uk/blog/twitter-monitoring-typewritter-twypwriter/.)

These are only a few random examples of what is possible using an
Arduino. You can create your own projects without much difficulty—and after
you’ve worked through this book, they are certainly not out of your reach.



Figure 1-5: Nixie tube Sudoku

Figure 1-6: The TwypeWriter
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Strength in Numbers

The Arduino platform increases in popularity every day. If you're more of a
social learner and enjoy class-oriented situations, search the Web for “Cult
of Arduino” to see what people are making and to find Arduino-related
groups. Members of Arduino groups introduce the world of Arduino from an
artist’s perspective. Many group members work to create a small Arduino-
compatible board at the same time. These groups can be a lot of fun, intro-
duce you to interesting people, and let you share your Arduino knowledge
with others.

Parts and Accessories

Chapter 1

As with any other electronic device, the Arduino is available from many
retailers that offer a range of products and accessories. When you're
shopping, be sure to purchase the original Arduino, not a knock-off,
or you run the risk of receiving faulty or poorly performing goods; why
risk your project with an inferior board that could end up costing you
more in the long run? For a list of Arduino suppliers, visit Attp://arduino
.cc/en/Main/Buy/.

Here’s a list of current suppliers (in alphabetical order) that I recom-
mend for your purchases of Arduino-related parts and accessories:

e Adafruit Industries (http://www.adafruit.com/)

e DigiKey (http://www.digikey.com/)

e Jameco Electronics (http://www.jameco.com/)

e Little Bird Electronics (http://www.littlebirdelectronics.com/)
e Newark (http://www.newark.com/)

e nicegear (http://www.nicegear.co.nz/)

e Oomlout (Attp://www.oomlout.co.uk/)

e RadioShack (http://www.radioshack.com/)

e RS Components (http://www.rs-components.com/)

e SparkFun Electronics (hitp://www.sparkfun.com/)

As you’ll see in this book, I use several Arduino-compatible products
from Freetronics (http://www.freetronics.com/). However, you will find that
all the required parts are quite common and easily available from various
resellers.

But don’t go shopping yet. Take the time to read the first few chapters
to get an idea of what you’ll need so that you won’t waste money buying
unnecessary things immediately.



Required Software

NOTE

You should be able to program your Arduino with just about any computer
using a piece of software called an integrated development environment (IDE).
To run this software, your computer should have one of the following oper-
ating systems installed:

e Mac OS X or higher
e Windows XP 32- or 64-bit, or higher
e Linux 32- or 64-bit (Ubuntu or similar)

Now is a good time to download and install the IDE, so jump to the
heading that matches your operating system and follow the instructions.
Make sure you have or buy the matching USB cable for your Arduino from
the supplier as well. Even if you don’t have your Arduino board yet, you can
still download and explore the IDE. Because the IDE version number can
change quite rapidly, the number in this book may not match the current
version, but the instructions should still work.

Unfortunately, as this book went to press, there were issues with Windows 8 instal-
lations. If you have Windows 8, visit the Arduino Forum at http://arduino.cc/
forum/index.php/topic,94651.15.html for guidance and discussion.

Mac 0S X

In this section, you’ll find instructions for downloading and configuring
the Arduino IDE in Mac OS X.

Installing the IDE

To install the IDE on your Mac, follow these instructions:

1. Using a web browser such as Safari, visit the software download page
located at http://arduino.cc/en/Main/Software/, as shown in Figure 1-7.

8anOn Arduino - Software
| > 4 @h(tp:,r,farduino.(c,fen,iMain,isuﬂware

¢ | (Qr Google

Main Site Blog Playground Forum Labs Store

Help | Signin or Register

Download Next steps
Arduino 0022 (release notes), hosted by Google Code: Getting Started m
. Reference
*+ Windows Environment
+ M.Za(:OS X - - E ples
+ Linux: 32 bit, 64 bit Foundations
+ source FAQ
Also available from Arduino.cc: Windows, Mac 08 X, Linux (32bit)
(64bit), Source a
v
- 3 Yl s

Figure 1-7: The IDE download page in Safari
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2. Click the Mac OS X link. The file will start downloading, and it will
appear in the Downloads window shown in Figure 1-8.

I,_.j arduino-0022.dmg _
d 735 MB Q

Figure 1-8: File download is complete.

3. Once it’s finished downloading, double-click the file to start the instal-
lation process. You will then be presented with the window shown in
Figure 1-9.

b4 3 items, 92.7 MB availabl P—

@ — A

Arduino Applications

o

FTDIUSBSerialDriver_10_4_
10_5_10_6

Figure 1-9: Your new Arduino IDE folder

NOTE The third file icon shown in Figure 1-9 needs to be installed only if you have an
Arduino board older than the current Uno.

8 Chapter 1
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4. Drag the Arduino icon over the Applications folder and release the

mouse button. A temporary status window will appear as the file is
copied.

Now connect your Arduino to your Mac with the USB cable. After a
moment, the dialog shown in Figure 1-10 will appear.

A new network interface has been detected.
By = The "Eleven " network interface has not been set up.

To set up this interface, use Network Preferences.

( Cancel ) f". ork Prefe|

b

Figure 1-10: A new Arduino board is detected. Your
dialog may read Uno instead of Eleven.

Click Network Preferences..., and then click Apply in the Network box.

You can ignore the “not configured” status message.

Setting Up the IDE

Once you have downloaded the IDE, use the following instructions to open
and configure the IDE:

1.

Open the Applications folder in Finder (shown in Figure 1-11) and
double-click the Arduino icon.

Address Book Adobe Arduino

=
N
v
A

Figure 1-11: Your Applications folder

A window may appear warning you about opening a web app. If it does,

click Open to continue. You will then be presented with the IDE, as
shown in Figure 1-12.

Getting Started
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® Arduino File Edit Sketch Tools Help
——— =

Figure 1-12: The IDE in Mac OS X

You're almost there—just two more things to do before your Arduino
IDE is ready to use. First, you need to tell the IDE which type of socket
the Arduino is connected to. Select Tools » Serial Port and select the
/dev/tty.usbmodemldll option, as shown in Figure 1-13.

Help

Auto Format ®T
E Archive Sketch

Fix Encoding & Reload
Serial Monitor {+38M

Board >
/dev/cu.usbmodemldll
Burn Bootloader > /dev/tty.Bluetooth-PDA-Sync
' /dev/cu.Bluetooth-PDA-Sync
/dev/tty.Bluetooth-Modem
/dev/cu.Bluetooth-Modem

Figure 1-13: Selecting the USB port

The final step is to tell the IDE which Arduino board you have connected.
This is crucial, since Arduino boards do differ. For example, if you have
the most common board, the Uno, then select Tools » Board » Arduino
Uno, as shown in Figure 1-14. The differences in Arduino boards are
explained in more detail in Chapter 11.

Now your hardware and software are ready to work for you. Next, move

on to “Safety” on page 18.



Tools JEGEN

Auto Format ®T
:| & Archive Sketch
: Fix Encoding & Reload
Serial Monitor DM

Serial Port > Arduino Duemilanove or Nano w/ ATmega328
Arduino Diecimila, Duemilanove, or Nano w/ ATmegal68
Burn Bootloader » Arduino Mega 2560
| Arduino Mega (ATmegal280)
Arduino Mini
Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ ATmegal68

LilyPad Arduino w/ ATmega328

LilyPad Arduino w/ ATmegal68
: Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328
Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmegal68
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmegal68
Arduino NG or older w/ ATmegal68
Arduino NG or older w/ ATmega8

Figure 1-14: Selecting the correct Arduino board

Windows XP and Later

In this section, you’ll find instructions for downloading the IDE, installing
drivers, and configuring the IDE in Windows.

Installing the IDE

To install the Arduino IDE for Windows, follow these instructions:

1. Using a web browser such as Firefox, visit the software download page
located at http://arduino.cc/en/Main/Software/, as shown in Figure 1-15.

i =]
@Ardulno—Sclﬂware IT] x
€& > [@ http://arduino.cc/en/Main/Software 1y~ C'] ["" Google P] 1' &
Main Site Blog Playground Forum Labs Store it
Download Next steps
Arduino ooz2 (release notes), hosted by Google Code: Getting Started
Reference o
Eindaws Environment
+ MacOSX Examples
+ Linux: 32 bit, 64 bit Foundations
+ source FAQ
Also available from Arduine.ce: Windows, Mae OS X, Linux (32bit) -
< n ] v

Figure 1-15: The IDE download page in Windows Firefox
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Click the Windows link, and the dialog shown in Figure 1-16 will appear.
Select Open with Windows Explorer, and then click OK. The file will
start to download, as shown in Figure 1-17.

I@Ardumﬂ-ﬁo&wﬂre

[==0E=]

| € | @ arduino.cc/en/Main/Sof{] 0P

- j
B~ Googie

i a5 tronixstuff | Profile | Help | Sign out [

You have chosen to open:
| 1) arduino-1.0.3-windows.zip
pownload which is : Compressed (zipped) Folder (91.2 ME)

from: http://arduino.googlecode.com

Main Site Blog Playground

Arduine 1.0.3 (rel|

What should Firefox do with this file?
+ Windows @ Qpen with | Windows Explorer (default) -
+ MacOSX
TeEEmS © Save File
+ Linux: 32 bit,|
+ source Do this automatically for fles like this from now on.

Download Ard

If you have the new Due Board you must download the 1.5.2 version. Once you get the software follow this instruction

Figure 1-16: Downloading the file

arduino-1.0.3-windows.zip

» h— ‘l o E|
2 minutes, 20 seconds remaining — 5.4 of 91.3 MB (776 kB/sec)

Search... r

Figure 1-17: Firefox shows the progress of your download.

Once the download is complete, double-click the file, and the window
shown in Figure 1-18 will appear.

@vL‘ v John.. » Downloads » R4 | 5 | | Search Downloads 2 |
Organize « &l Open = Share with MNew folder =~ 0 0
¢ Favorites EI B Pate

Pl Desktop ||_iu arduine-1.0.3-windows 7/03
g Downloads

| Recent Places

5 Librries —— »
] arduino-1.0.3-windows  Date modified: 7/03/2013 1:19 PM
Compressed (zipped] Folder Size: 91.2 MB
Date created: 7/03/2013 1:16 PM

Figure 1-18: The IDE package




4. Copy the folder named arduino-0022 (or something similar) to the loca-
tion where you store your applications. Once the copying is finished,
locate the folder and open it to reveal the Arduino application icon, as
shown in Figure 1-19. You may wish to copy the icon and place a short-
cut on the desktop for easier access in the future.

[E=1 =R 5
& )=[1 » Ubreries » Documents » clectonics » orduino-103 » [ 44| [ Search arduino-1.03 2|
Organize * Sharewith »  New folder 2|~ 0 @
7t Favorites — Documents library Aitarige by Folder
B Deskiop arduino-1.03
& Downloads E [ E NER= FE R ! e
&l Recent Places drivers examples hardware java lib
Lib 1 S ]
=5 Libraries .
3 ¥ 3
|5 Documents l | i % LT’A 4
| \ P
o' Music ‘ | E - L4
K
B e lib . of I dui 2.dll
H Videos i ibraries reference tools arduino cygiconv-2. N
14 items
State: 2 Shared

Figure 1-19: Your IDE folder with the Arduino application icon selected

Installing Drivers

The next task is to install the drivers for your Arduino board’s USB interface.

1. Connect your Arduino to your PC with the USB cable. After a few
moments an error message will be displayed, which will say something
like “Device driver software not successfully installed.” Just close that

dialog or balloon.

2. Navigate to the Windows Control Panel. Open the Device Manager and
scroll down until you see the Arduino, as shown in Figure 1-20.

=1 Device Manager
File Action View Help

&= = H=E =

=N NCR

[+ ¥ Metwork adapters
4 5 Other devices
[l Arduine Uno
» 0¥ Processors

|>-#% Sound, video and game controllers
N S S Y

Figure 1-20: The Device Manager
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Right-click Arduino Uno under Other Devices and select Update Driver
Software. Then, select the Browse my computer for driver software
option that appears in the next dialog. Another Browse For Folder dialog
will appear; click Browse, and navigate to the drivers folder in the newly
installed Arduino software folder (shown in Figure 1-21). Click OK.

-

@ [l Update Driver Softwa Browse For Folder @
Select the folder that contains drivers for your hardware.
Browse for driver s
4 | arduino-1.0.3 &
Search for driver software > T
C:\Users\John Boxall\Do > examples | :]
» J hardware R
[¥] Include subfolders X
> java
> lib
> libraries
> . reference
. > tools e
@ Letme pickfro| | = >
This list will show ir r
software in the sam| Folder- drivers

Figure 1-21: Locating the drivers folder

Click Next in the dialog that follows. Windows may present a message
stating that it “cannot verify the publisher of the driver software.” Click
Install this software anyway. After a short wait, Windows will tell you
that the driver is installed and the COM port number the Arduino is
connected to, as shown in Figure 1-22.

=l

() L Update Driver Software - Arduino UNO RS (COMLS)
Windows has successfully updated your driver software

Windows has finished installing the driver software for this device:

Arduino UNO R3

Close

Figure 1-22: The drivers have been updated successfully.



Setting Up the IDE

Okay, we're almost there—just two more things to do to finish setting up
the IDE.

1. Open the Arduino IDE. You need to tell the IDE which type of socket
the Arduino is connected to by selecting Tools » Serial Port and
selecting the COM port number that appeared in the Update Driver
Software window.

2. The final step is to tell the IDE which Arduino board we have connected.

This is crucial, as the Arduino boards do differ. For example, if you
have the Uno, select Tools » Board » Arduino Uno. The differences in
Arduino boards are explained in more detail in Chapter 11.

Now that your Arduino IDE is set up, you can move on to “Safety” on
page 18.

Ubuntu Linux 9.04 and Later

If you are running Ubuntu Linux, here are instructions for downloading
and setting up the Arduino IDE.

Installing the IDE

Use the following instructions to install the IDE:

1. Using a web browser such as Firefox, visit the software download page
located at http://arduino.cc/en/Main/Software/, as shown in Figure 1-23.

Arduino - Software - Mozilla Firefox

Tools

File Edit View History Bookmarks Help

+

& Arduino - Software

= | &) http://arduino.cc/en/Main/software

Main Site Blog Playground Forum Labs Store

Download

Arduino 0022 (release notes), hosted by Google Code:

+ Windows
+ Mac OS X
+ Linux: 32 bit, 64 bit

+ source

Figure 1-23: The IDE download page in Ubuntu Firefox

Getting Started
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2. Click the Linux 32-bit or 64-bit link, depending on your system. When
the dialog in Figure 1-24 appears, select Open with Archive Manager

and click OK.

Opening arduino-0022-64-2.tgz

You have chosen to open
[ arduino-0022-64-2.tgz

whichis a: Gzip archive
from: http://arduino.googlecode.com

What should Firefox do with this File?

@® |open with| [ Archive Manager (default) = J

() Save File

[[J Do this automatically For Files like this from now on.

Cancel OK

Figure 1-24: Downloading the file

3. After the file has downloaded, it will be displayed in the Archive
Manager, as shown in Figure 1-25. Copy the arduino-0022 folder
(or something similar) to your usual application or Home folder.

arduino-0022-64-2.tgz [read only]

Archive Edit

| & l@@open ~ [k Extract

Back @ Location: |/ |
Name » | Size Type
[F~ arduino-0022 7.9MB Folder

1 object (7.9 MB), 1 object selectli_\_.___,__’h

Figure 1-25: The IDE package

Setting Up the IDE
Next, you’ll configure the IDE.

1. Connect your Arduino to your PC with the USB cable. At this
point you want to run the Arduino IDE, so locate the arduino-0022
folder you copied earlier and double-click the arduino file that’s

selected in Figure 1-26.
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arduino-0022

File Edit 3ookmarks Help

&Back ~ Forwar T+ (o B Q 10% ) v

4 ||[@john || arduino-0022 |

- - -, -

examples hardware lib libraries
ARDUT

- .
—_—

reference tools arduino revisions.txt

"arduino” selected (435 bytes), Free space: 233.6 GB

Figure 1-26: Your Arduino IDE folder with the arduino file selected

If the dialog shown in Figure 1-27 appears, click Run, and you will be
presented with the IDE, as shown in Figure 1-28.

Do you want to run "arduino",
@ or display its contents?

"arduino” is an executable text file.

| Runin Terminal | | Display [ | Cancel [l Run.

Figure 1-27: Granting permission to run the IDE

sketch_aug07a | Arduino 0022
Fil= [Eah & =

1

Figure 1-28: The IDE in Ubuntu
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3. Now that the IDE is running, we need to tell it which type of socket the
Arduino is connected to. Select Tools » Serial Port and select the /dev/
ttyACMx port, where x is a single digit (there should be only one port
with a name like this).

4. Next, tell the IDE which Arduino you have connected. This is crucial,
as Arduino boards do differ. For example, if you have the Uno, select
Tools » Board » Arduino Uno. The differences in Arduino boards are
explained in more detail in Chapter 11.

Now your hardware and software are ready to work for you.

Safety

As with any hobby or craft, it’s up to you to take care of yourself and those
around you. As you’ll see in this book, I discuss working with basic hand
tools, battery-powered electrical devices, sharp knives, and cutters—and
sometimes soldering irons. At no point in your projects should you work
with the mains current. Leave that to a licensed electrician who is trained
for such work. Remember that contacting the mains current will kill you.

Looking Ahead

You’re about to embark on a fun and interesting journey, and you’ll be cre-
ating things you may never have thought possible. You’ll find 65 Arduino

projects in this book, ranging from the very simple to the relatively complex.
All are designed to help you learn and make something useful. So let’s go!
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EXPLORING THE ARDUINO BOARD
AND THE IDE

In this chapter you’ll explore the Arduino board as
well as the IDE software that you’ll use to create and
upload Arduino sketches (Arduino’s name for its pro-
grams) to the Arduino board itself. You'll learn the
basic framework of a sketch and some basic functions
that you can implement in a sketch, and you’ll create
and upload your first sketch.

The Arduino Board

What exactly is Arduino? According to the Arduino website (http://www.
arduino.cc/), it is

an open-source electronics prototyping platform based on flex-
ible, easy-to-use hardware and software. It’s intended for artists,
designers, hobbyists, and anyone interested in creating inter-
active objects or environments.
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In simple terms, the Arduino is a tiny computer system that can be pro-
grammed with your instructions to interact with various forms of input and
output. The current Arduino board model, the Uno, is quite small in size
compared to the average human hand, as you can see in Figure 2-1.

Figure 2-1: An Arduino Uno is quite small.

Although it might not look like much to the new observer, the Arduino
system allows you to create devices that can interact with the world around
you. By using an almost unlimited range of input and output devices, sen-
sors, indicators, displays, motors, and more, you can program the exact
interactions required to create a functional device. For example, artists
have created installations with patterns of blinking lights that respond to
the movements of passers-by, high school students have built autonomous
robots that can detect an open flame and extinguish it, and geographers
have designed systems that monitor temperature and humidity and trans-
mit this data back to their offices via text message. In fact, you’ll find an
almost infinite number of examples with a quick search on the Internet.

Now let’s move on and explore our Arduino Uno hardware (in other
words, the “physical part”) in more detail and see what we have. Don’t worry
too much about understanding what you see here, because all these things
will be discussed in greater detail in later chapters.



Let’s take a quick tour of the Uno. Starting at the left side of the board,
you’ll see two connectors, as shown in Figure 2-2.

Figure 2-2: The USB and power connectors

On the far left is the Universal Serial Bus (USB) connector. This con-
nects the board to your computer for three reasons: to supply power to the
board, to upload your instructions to the Arduino, and to send data to and
receive it from a computer. On the right is the power connector. Through
this connector, you can power the Arduino with a standard mains power
adapter.

At the lower middle is the heart of the board: the microcontroller, as
shown in Figure 2-3.

Figure 2-3: The microcontroller

The microcontrolleris the “brains” of the Arduino. Itis a tiny computer
that contains a processor to execute instructions, includes various types of
memory to hold data and instructions from our sketches, and provides vari-
ous avenues of sending and receiving data. Just below the microcontroller
are two rows of small sockets, as shown in Figure 2-4.

Exploring the Arduino Board and the IDE 21



22

Chapter 2

Figure 2-4: The power and analog sockets

The first row offers power connections and the ability to use an exter-
nal RESET button. The second row offers six analog inputs that are used
to measure electrical signals that vary in voltage. Furthermore, pins A4
and A5 can also be used for sending data to and receiving it from other
devices. Along the top of the board are two more rows of sockets, as shown
in Figure 2-5.

M N -S
? A~V
DIGITAL (PWM~) ¥ &

Figure 2-5: The digital input/output pins

Sockets (or pins) numbered 0 to 13 are digital input/output (I/0)
pins. They can either detect whether or not an electrical signal is present
or generate a signal on command. Pins 0 and 1 are also known as the serial
port, which is used to send and receive data to other devices, such as a com-
puter via the USB connector circuitry. The pins labeled with a tilde (~) can
also generate a varying electrical signal, which can be useful for such things
as creating lighting effects or controlling electric motors.

Next are some very useful devices called light-emitting diodes (LEDs); these
very tiny devices light up when a current passes through them. The Arduino
board has four LEDs: one on the far right labeled ON, which indicates when
the board has power, and three in another group, as shown in Figure 2-6.

The LEDs labeled TX and RXlight up when data is being transmitted
or received between the Arduino and attached devices via the serial port
and USB. The L LED is for your own use (it is connected to the digital I/O
pin number 13). The little black square part to the left of the LEDs is a tiny
microcontroller that controls the USB interface that allows your Arduino to
send data to and receive it from a computer, but you don’t generally have to
concern yourself with it.
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Figure 2-6: The onboard LEDs

And, finally, the RESET button is shown in Figure 2-7.

Figure 2-7: The RESET button

As with a normal computer, sometimes things can go wrong with the
Arduino, and when all else fails, you might need to reset the system and
restart your Arduino. This simple RESET button on the board (Figure 2-7)
is used to restart the system to resolve these problems.

One of the great advantages of the Arduino system is its ease of
expandability—that is, it’s easy to add more hardware functions. The two
rows of sockets along each side of the Arduino allow the connection of a
shield, another circuit board with pins that allow it to plug into the Arduino.
For example, the shield shown in Figure 2-8 contains an Ethernet interface
that allows the Arduino to communicate over networks and the Internet,
with plenty of space for custom circuitry.

Notice how the Ethernet shield also has rows of sockets. These enable
you to insert one or more shields on top. For example, Figure 2-9 shows that
another shield with a large numeric display, temperature sensor, extra data
storage space, and a large LED has been inserted.

Note that you do need to remember which shield uses which individual
inputs and outputs to ensure that “clashes” do not occur. You can also pur-
chase completely blank shields that allow you to add your own circuitry.
This will be explained further in Chapter 8.
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Figure 2-9: Numeric display and temperature shield
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Taking a

Command
Area

Text Area /

Message ~

Window Area

The companion to the Arduino hardware is the software, a collection of
instructions that tell the hardware what to do and how to do it. Two types of
software can be used: The first is the integrated development environment
(IDE), which is discussed in this chapter, and the second is the Arduino
sketch you create yourself.

The IDE software is installed on your personal computer and is used to
compose and send sketches to the Arduino board.

Look Around the IDE

As shown in Figure 2-10, the Arduino IDE resembles a simple word processor.
The IDE is divided into three main areas: the command area, the text area,
and the message window area.

&9 sketch_mar22a | Arduino 1.0 =N e = .

File Edit Sketch Tools Help T|1|e Bar
Menu ltems
Icons

sketch_mar22a

Figure 2-10: The Arduino IDE

The Command Area

The command area is shown at the top of Figure 2-10 and includes the
title bar, menu items, and icons. The title bar displays the sketch’s filename
(sketch_mar22a), as well as the version of the IDE (Arduino 1.0). Below this
is a series of menu items (File, Edit, Sketch, Tools, and Help) and icons, as
described next.

Exploring the Arduino Board and the IDE 25
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Menvu ltems

As with any word processor or text editor, you can click one of the menu
items to display its various options.

File Contains options to save, load, and print sketches; a thorough set
of example sketches to open; as well as the Preferences submenu

Edit Contains the usual copy, paste, and search functions common to
any word processor

Sketch Contains the function to verify your sketch before uploading
to a board, and some sketch folder and import options

Tools Contains a variety of functions as well as the commands to
select the Arduino board type and USB port

Help Contains links to various topics of interest and the version of
the IDE

The Icons

Below the menu toolbar are six icons. Mouse over each icon to display its
name. The icons, from left to right, are as follows:

Verify Click this to check that the Arduino sketch is valid and doesn’t
contain any programming mistakes.

Upload Click this to verify and then upload your sketch to the
Arduino board.

New Click this to open a new blank sketch in a new window.
Open Click this to open a saved sketch.

Save Click this to save the open sketch. If the sketch doesn’t have a
name, you will be prompted to create one.

Serial Monitor Click this to open a new window for use in sending
and receiving data between your Arduino and the IDE.

The Text Area

The text area is shown in the middle of Figure 2-10; this is where you’ll create
your sketches. The name of the current sketch is displayed in the tab at the
upper left of the text area. (The default name is the current date.) You’ll
enter the contents of your sketch here as you would in any text editor.

The Message Window Area

The message window area is shown at the bottom of Figure 2-10. Messages
from the IDE appear in the black area. The messages you see will vary and
will include messages about verifying sketches, status updates, and so on.



At the bottom right of the message area, you should see the name
of your Arduino board type as well as its connected USB port—Arduino
Duemilanove w/ATmega328 on COMG6 in this case.

Creating Your First Sketch in the IDE

NOTE

An Arduino sketch is a set of instructions that you cre-
ate to accomplish a particular task; in other words, a
sketch is a program. In this section you’ll create and
upload a simple sketch that will cause the Arduino’s
LED (shown in Figure 2-11) to blink repeatedly, by

turning it on and then off for 1 second intervals. Figure 2-11: The

LED on the Arduino
Don’t worry too much about the specific commands in the boa'r d, next fo the
sketch we’re creating here. The goal is to show you how easy it capital L

is to get the Arduino to do something so that yow'll keep read-
ing when you get to the harder stuff.

To begin, connect your Arduino to the computer with the USB cable.
Then open the IDE, choose Tools » Serial Port, and make sure the USB
port is selected. This ensures that the Arduino board is properly connected.

Comments

First, enter a comment as a reminder of what your sketch will be used for.
A comment is a note of any length in a sketch, written for the user’s benefit.
Comments in sketches are useful for adding notes to yourself or others, for
entering instructions, or for noting miscellaneous details. When program-
ming your Arduino (creating sketches), it’s a good idea to add comments
regarding your intentions; these comments can prove useful later when
you're revisiting a sketch.

To add a comment on a single line, enter two forward slashes and then
the comment, like this:

// Blink LED sketch by Mary Smith, created 09/09/12

The two forward slashes tell the IDE to ignore the text that follows
when verifying a sketch. (As mentioned earlier, when you verify a sketch,
you're asking the IDE to check that everything is written properly with
Nno errors.)

To enter a comment that spans two or more lines, enter the characters
/* on a line before the comment, and then end the comment with the char-
acters */ on the following line, like this:

/*

Arduino Blink LED Sketch

by Mary Smith, created 09/09/12
*/

Exploring the Arduino Board and the IDE 27
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As with the two forward slashes that precede a single line comment, the
/* and */ tell the IDE to ignore the text that they bracket.

Enter a comment describing your Arduino sketch using one of these
methods, and then save your sketch by choosing File » Save As. Enter a
short name for your sketch (such as blinky), and then click OK.

The default filename extension for Arduino sketches is .ino, and the
IDE should add this automatically. The name for your sketch should be, in
this case, blinky.ino, and you should be able to see it in your Sketchbook.

The Setup Function

The next stage in creating any sketch is to add the void setup() function.
This function contains a set of instructions for the Arduino to execute once
only, each time it is reset or turned on. To create the setup function, add the
following lines to your sketch, after the comments:

void setup()

Controlling the Hardware

Our program will blink the user LED on the Arduino. The user LED is
connected to the Arduino’s digital pin 13. A digital pin can either detect
an electrical signal or generate one on command. In this project, we’ll
generate an electrical signal that will light the LED. This may seem a little
complicated, but you’ll learn more about digital pins in future chapters. For
now, just continue with creating the sketch.

Enter the following into your sketch between the braces ({ and }):

pinMode(13, OUTPUT); // set digital pin 13 to output

The number 13 in the listing represents the digital pin you're addressing.
You're setting this pin to OUTPUT, which means it will generate (output) an elec-
trical signal. If you wanted it to detect an incoming electrical signal, then you
would use INPUT instead. Notice that the function pinMode() ends with a semi-
colon (;). Every function in your Arduino sketches will end with a semicolon.

Save your sketch again to make sure that you don’t lose any of your work.

The Loop Function

Remember that our goal is to make the LED blink repeatedly. To do this,
we’ll create a loop function to tell the Arduino to execute an instruction over
and over until the power is shut off or someone presses the RESET button.

Enter the code shown in boldface after the void setup() section in the
following listing to create an empty loop function. Be sure to end this new
section with another brace (}), and then save your sketch again.



WARNING

/*

Arduino Blink LED Sketch

by Mary Smith, created 09/09/12
*/

void setup()

pinMode(13, OUTPUT); // set digital pin 13 to output
}
void loop()

// place your main loop code here:

}

The Arduino IDE does not automatically save sketches, so save your work frequently!

Next, enter the actual functions into void loop() for the Arduino to
execute.

Enter the following between the loop function’s braces, and then click
Verify to make sure that you've entered everything correctly:

digitalWrite(13, HIGH); // turn on digital pin 13
delay(1000); // pause for one second
digitalWrite(13, LOW); // turn off digital pin 13
delay(1000); // pause for one second

Let’s take this all apart. The digitalWrite() function controls the voltage
that is output from a digital pin: in this case, pin 13 to the LED. By setting
the second parameter of this function to HIGH, a “high” digital voltage is out-
put; then current will flow from the pin and the LED will turn on. (If you
were to set this parameter to LOW, then the current flowing through the LED
would stop.)

With the LED turned on, the light pauses for 1 second with delay(1000).
The delay() function causes the sketch to do nothing for a period of time—
in this case, 1,000 milliseconds, or 1 second.

Next, we turn off the voltage to the LED with digitalWrite(13, LOW);.
Finally, we pause again for 1 second while the LED is off, with delay(1000);.

The completed sketch should look like this:

/*

Arduino Blink LED Sketch

by Mary Smith, created 09/09/12
*/

void setup()

pinMode(13, OUTPUT); // set digital pin 13 to output
}
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void loop()

digitalWrite(13, HIGH); // turn on digital pin 13
delay(1000); // pause for one second
digitalWrite(13, LOW); // turn off digital pin 13
delay(1000); // pause for one second

Before you do anything further, save your sketch!

Verifying Your Sketch

When you verify your sketch, you ensure that it has been written correctly

in a way that the Arduino can understand. To verify your complete sketch,
click Verify in the IDE and wait a moment. Once the sketch has been veri-
fied, a note should appear in the message window, as shown in Figure 2-12.

4 3

aximum)

Arduing Uno o

Figure 2-12: The sketch has been verified.

This “Done compiling” message tells you that the sketch is okay to upload
to your Arduino. It also shows how much memory it will use (1,076 bytes in
this case) of the total available on the Arduino (32,256 bytes).

But what if your sketch isn’t okay? Say, for example, you forgot to add a
semicolon at the end of the second delay(1000) function. If something is bro-
ken in your sketch, then when you click Verify, the message window should
display a verification error message similar to the one shown in Figure 2-13.

digitalWrite (13, LOW); /7 turn off digital pin 13
delay(l000) /7 pause for one second

*'before 'Y token

Arduine Uno on COM14

Figure 2-13: The message window with a verification error



The message tells you that the error occurs in the void loop function,
lists the line number of the sketch where the IDE thinks the error is located
(blinky:16, or line 16 of your blinky sketch), and displays the error itself (the
missing semicolon, error: expected ';' before '}' token). Furthermore, the
IDE should also highlight in yellow the location of the error or a spot just
after it. This helps you easily locate and rectify the mistake.

Uploading and Running Your Sketch

Once you're satisfied that your sketch has been entered correctly, save it,
ensure that your Arduino board is connected, and click Upload in the IDE.
The IDE may verify your sketch again and then upload it to your Arduino
board. During this process, the TX/RX LEDs on your board (shown in
Figure 2-6) should blink, indicating that information is traveling between
the Arduino and your computer.

Now for the moment of truth: Your Arduino should start running the
sketch. If you've done everything correctly, then the LED should blink on
and off once every second!

Congratulations. You now know the basics of how to enter, verify, and
upload an Arduino sketch.

Modifying Your Sketch

After running your sketch, you may want to change how it operates, by, for
example, adjusting the on or off delay time for the LED. Because the IDE

is a lot like a word processor, you can open your saved sketch, adjust the
values, and then save your sketch again and upload it to the Arduino. For
example, to increase the rate of blinking, change both delay functions to
make the LEDs blink for one-quarter of a second by adjusting the delay to 250
like this:

delay(250); // pause for one-quarter of one second

Then upload the sketch again. The LED should now blink faster, for
one-quarter of a second each time.

Looking Ahead

Armed with your newfound knowledge of how to enter, edit, save, and
upload Arduino sketches, you're ready for the next chapter, where you’ll
learn how to use more functions, implement good project design, construct
basic electronic circuits, and do much more.
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FIRST STEPS

In this chapter you will

e Learn the concepts of good project design
e Learn the basic properties of electricity

e Be introduced to the resistor, light-emitting diode (LED), transistor,
rectifier diode, and relay

e Use a solderless breadboard to construct circuits

e Learn how integer variables, for loops, and digital outputs can be used
to create various LED effects

Now you’ll begin to bring your Arduino to life. As you will see, there is
more to working with Arduino than just the board itself. You’ll learn how
to plan projects in order to make your ideas a reality and then move on to
a quick primer on electricity. Electricity is the driving force behind every-
thing we do in this book, and it’s important to have a solid understanding
of the basics in order to create your own projects. You’ll also take a look at
the components that help bring real projects to life. Finally, you’ll examine
some new functions that are the building blocks for your Arduino sketches.
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Planning Your Projects

NOTE

When starting your first few projects, you might be tempted to write your
sketch immediately after you've come up with a new idea. But before you
start writing, a few basic preparatory steps are in order. After all, your
Arduino board isn’t a mind-reader; it needs precise instructions, and even
if these instructions can be executed by the Arduino, the results may not be
what you expected if you overlooked even a minor detail.

Whether you are creating a project that simply blinks a light or an auto-
mated model railway signal, a detailed plan is the foundation of success.
When designing your Arduino projects, follow these basic steps:

Define your objective. Determine what you want to achieve.

2. Write your algorithm. An algorithm is a set of instructions that describes
how to accomplish your project. Your algorithm will list the steps neces-
sary for you to achieve your project’s objective.

3. Select your hardware. Determine how it will connect to the Arduino.

4. Write your sketch. Create your initial program that tells the Arduino
what to do.

5. Wire it up. Connect your hardware, circuitry, and other items to the
Arduino board.

6. Test and debug. Does it work? During this stage, you identify errors and
find their causes, whether in the sketch, hardware, or algorithm.

The more time you spend planning your project, the easier time you’ll
have during the testing and debugging stage.

Even well-planned projects sometimes fall prey to feature creep. Feature creep occurs
when people think wp new functionality that they want to add to a project and then
try to force new elements into an existing design. When you need to change a design,
don’t try to “slot in” or modify it with 11th-hour additions. Instead, start fresh by
redefining your objective.

About Electricity

Chapter 3

Let’s spend a bit of time discussing electricity, since you’ll soon be building
electronic circuits with your Arduino projects. In simple terms, electricity is a
form of energy that we can harness and convert into heat, light, movement,
and power. Electricity has three main properties that will be important to
us as we build projects: current, voltage, and power.

Current

The flow of electrical energy through a circuit is called the current. Electrical
current flows through a circuit from the positive side of a power source,
such as a battery, to the negative side of the power source. This is known
as direct current (DC). For the purposes of this book, we will not deal with



AC (alternating current). In some circuits, the negative side is called ground
(GND). Current is measured in amperes or “amps” (A). Small amounts

of current are measured in milliamps (mA), where 1,000 milliamps equal

1 amp.

Voltage

Voltage is a measure of the difference in potential energy between a circuit’s
positive and negative ends. This is measured in volts (V). The greater the
voltage, the faster the current moves through a circuit.

Power

Power is a measurement of the rate at which an electrical device converts
energy from one form to another. Power is measured in watts (W). For
example, a 100 W light bulb is much brighter than a 60 W bulb because
the higher-wattage bulb converts more electrical energy into light.

A simple mathematical relationship exists among voltage, current,
and power:

Power (W) = Voltage (V) x Current (A)

Electronic Components

Now that you know a little bit about the basics of electricity, let’s look at
how it interacts with various electronic components and devices. Electronic
components are the various parts that control electric current in a circuit to
make our designs a reality. Just as the various parts of a car work together
to provide fuel, power, and mobility to allow us to drive, electronic compo-
nents work together to control and harness electricity to help us create use-
ful devices.

Throughout this book, I'll explain specialized components as we
use them. The following sections describe some of the fundamental
components.

The Resistor

Various components, such as the Arduino’s LED, require only a small
amount of current to function—usually around 10 mA. When the LED
receives excess current, it converts the excess to heat—too much of which
can kill an LED. To reduce the flow of current to components such as
LEDs, we can add a resistor between the voltage source and the component.
Current flows freely along normal copper wire, but when it encounters a
resistor, its movement is slowed. Some current is converted into a small
amount of heat energy, which is proportional to the value of the resistor.
Figure 3-1 shows an example of commonly used resistors.
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Figure 3-1: Typical resistors

Resistance

The level of resistance can be either fixed or variable. Resistance is mea-
sured in ohms () and can range from zero to thousands of ohms (kiloohms,
or kQ) to millions of ohms (megohms, or MQ).

Reading Resistance Values

Resistors are very small, so their resistance value usually cannot be printed
on the components themselves. Although you can test resistance with a mul-
timeter, you can also read resistance directly from a physical resistor, even
without numbers. One common way to show the component’s resistance is
with a series of color-coded bands, read from left to right, as follows:

First band Represents the first digit of the resistance
Second band Represents the second digit of the resistance

Third band Represents the multiplier (for four-band resistors) or the
third digit (for five-band resistors)

Fourth band Represents the multiplier for five-band resistors

Fifth band Shows the tolerance (accuracy)

Table 3-1 lists the colors of resistors and their corresponding values.

The fifth band represents a resistor’s tolerance. This is a measure of the
accuracy of the resistor. Because it is difficult to manufacture resistors with
exact values, you select a margin of error as a percentage when buying a
resistor. A brown band indicates 1 percent, gold indicates 5 percent, and
silver indicates 10 percent tolerance.

Figure 3-2 shows a resistor diagram. The yellow, violet, and orange resis-
tance bands are read as 4, 7, and 3, respectively, as listed in Table 3-1. These
values translate to 47,000 Q, more commonly read as 47 kQ.
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yellow orange
. .
t t

] [ ]

T T
violet brown

Figure 3-2: Example resistor diagram

Table 3-1: Values of Bands Printed on a Resistor, in Ohms

Color Ohms

Black
Brown
Red
Orange
Yellow
Green
Blue
Violet
Gray
White

O © N 00 o N W N — O

Chip Resistors

Surface-mount chip resistors display a
printed number and letter code, as shown

in Figure 3-3, instead of color stripes. The first
two digits represent a single number, and the
third digit represents the number of zeros to
follow that number. For example, the resis-
tor in Figure 3-3 has a value of 10,000 €2, or
10 kQ.

If you see a number and letter code on small

chip resistors (such as 01C), google EIA-96 code
calculator for lookup tables on that more involved
code system.

Figure 3-3: Example of a
surface-mount resistor
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Multimeters

A multimeteris an incredibly useful and relatively inexpensive piece of test
equipment that can measure voltage, resistance, current, and more. For
example, Figure 3-4 shows a multimeter measuring a resistor.

8
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Figure 3-4: Multimeter measuring a 560-ohm 1 percent
tolerance resistor

If you are colorblind, a multimeter is essential. As with other good tools,
purchase your multimeter from a reputable retailer instead of fishing about
on the Internet for the cheapest one you can find.

Power Rating

The resistor’s power rating is a measurement of the power, in watts, that it
will tolerate before overheating or failing. The resistors shown in Figure 3-1
are 1/4-watt resistors, which are the most commonly used resistors with the
Arduino system.

When you’re selecting a resistor, consider the relationship among
power, current, and voltage. The greater the current and/or voltage, the
greater the resistor’s power.

Usually, the greater a resistor’s power rating, the greater its physical
size. For example, the resistor shown in Figure 3-5 is a 5-watt resistor, which
measures 26 mm long by 7.5 mm wide.

Figure 3-5: A 5-watt resistor



The Light-Emitting Diode

The LED is a very common, infinitely useful component that converts elec-
trical current into light. LEDs come in various shapes, sizes, and colors.
Figure 3-6 shows a common LED.
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Figure 3-6: Red LED, 5 mm in diameter

Connecting LEDs in a circuit takes some care, because they are polarized;
this means that current can enter and leave the LED in one direction only.
The current enters via the anode (positive) side and leaves via the cathode
(negative) side, as shown in Figure 3-7. Any attempt to make too much
current flow through an LED in the opposite direction will break the
component.

Thankfully, LEDs are designed so that you can tell which end is which.
The leg on the anode side is longer, and the rim at the base of the LED is
flat on the cathode side, as shown in Figure 3-8.

LED1
Red (633nm)

¥

- L -

anode

anode cathode +
e —_
current flow cathode

Figure 3-7: Current flow Figure 3-8: LED design indicates the

through an LED anode (longer leg) and cathode (flat

rim) sides.

When adding LEDs to a project, you need to consider the operating
voltage and current. For example, common red LEDs require around 1.7 V
and 5 to 20 mA of current. This presents a slight problem for us, because
the Arduino outputs a set 5 V and a much higher current. Luckily, we can
use a current-limiting resistor to reduce the current flow into an LED. But
which value resistor do we use? That’s where Ohm’s Law comes in.
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To calculate the required current-limiting resistor for an LED, use this
formula:

R=(V,-V) +1

where Viis the supply voltage (Arduino outputs 5 V); V,is the LED forward
voltage drop (say, 1.7 V), and Iis the current required for the LED (10 mA).
(The value of I must be in amps, so 10 mA converts to 0.01 A.)

Now let’s use this for our LEDs—with a value of 5 V for V;, 1.7V for V,
and 0.01 A for 1. Substituting these values into the formula gives a value
for Rof 330 Q. However, the LEDs will happily light up when fed current
less than 10 mA. It’s good practice to use lower currents when possible to
protect sensitive electronics, so we’ll use 560 Q, 1/4-watt resistors with our
LEDs, which allow around 6 mA of current to flow.

When in doubt, always choose a slightly higher value resistor, because it’s better to
have a dim LED than a dead one!

THE OHM’S LAW TRIANGLE

Ohm's Law states that the relationship between current, resistance, and voltage
is as follows:

voltage (V) = current (I) x resistance (R)

If you know two of the quantities, then you can calculate the third. A popu-
lar way to remember Ohm’s Law is with a triangle, as shown in Figure 3-9.

Figure 3-9: The Ohm’s Law triangle

The Ohm’s Law triangle diagram is a convenient tool for calculating
voltage, current, or resistance when two of the three values are known. For
example, if you need to calculate resistance, put your finger over R, which
leaves you with voltage divided by current; to calculate voltage, cover V,
which leaves you with current times resistance.




The Solderless Breadboard

Our ever-changing circuits will need a base—something to hold them
together and build upon. A great tool for this purpose is a solderless
breadboard. The breadboard is a plastic base with rows of electrically con-
nected sockets (just don’t cut bread on them). They come in many sizes,
shapes, and colors, as shown in Figure 3-10.

Figure 3-10: Breadboards in various shapes and sizes

The key to using a breadboard is knowing how the sockets are
connected—whether in short columns or in long rows along the edge
or in the center. The connections vary by board. For example, in the
breadboard shown at the top of Figure 3-11, columns of five holes are
connected vertically but isolated horizontally. If you place two wires in
one vertical row, then they will be electrically connected. By the same
token, the long rows in the center between the horizontal lines are con-
nected horizontally. Because you’ll often need to connect a circuit to the
supply voltage and ground, these long horizontal lines of holes are ideal
for the supply voltage and ground.

When you’re building more complex circuits, a breadboard will get
crowded and you won’t always be able to place components exactly where
you want. It’s easy to solve this problem using short connecting wires, how-
ever. Retailers that sell breadboards usually also sell small boxes of wires of
various lengths, such as the assortment shown in Figure 3-12.

First Steps 41



¥ FE R NN D AEEEN
FEEEDNERNNDY N
AEEE D EWNE RN
"R EREEYEREENEREY
‘ﬁﬁiti%fﬁﬂﬁ

4 3 anm=
4 AAaAnR
4 3 aAas

=

3

Figure 3-12: Assorted breadboard wires
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Let’s put some LEDs and resistors to work. In this project, we’ll use five
LEDs to emulate the front of the famous TV show vehicle KITT from the
television show Knight Rider, creating a kind of wavelike light pattern.

The Algorithm

Here’s our algorithm for this project:

Turn on LED 1.
Wait half a second.
Turn off LED 1.
Turn on LED 2.
Wait half a second.
Turn off LED 2.

Continue until LED 5 is turned on, at which point the process reverses
from LED 5 to 1.

8. Repeat indefinitely.

NS Otk o =

The Hardware

Here’s what you’ll need to create this project:
e Five LEDs

e Five 560 Q resistors

e  One breadboard

e Various connecting wires
e Arduino and USB cable

We will connect the LEDs to digital pins 2 through 6 via the 560-ohm
current-limiting resistors.

The Sketch

Now for our sketch. Enter this code into the IDE:

// Project 1 - Creating a Blinking LED Wave
® void setup()

pinMode(2, OUTPUT); // LED 1 control pin is set up as an output
pinMode(3, OUTPUT); // same for LED 2 to LED §

pinMode(4, OUTPUT);

pinMode(5, OUTPUT);

pinMode(6, OUTPUT);
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® void loop()

digitalWrite(2, HIGH); // Turn LED 1 on
delay(500); // wait half a second
digitalWrite(2, LOW); // Turn LED 1 off
digitalWrite(3, HIGH); // and repeat for LED 2 to 5
delay(500);

digitallrite(3, LOW);

digitalWrite(4, HIGH);

delay(500);

digitallrite(4, LOW);

digitallWrite(5, HIGH);

delay(500);

digitalWrite(5, LOW);

digitalWrite(6, HIGH);

delay(500);

digitallWrite(6, LOW);

digitallWrite(5, HIGH);

delay(500);

digitallWrite(5, LOW);

digitalWrite(4, HIGH);

delay(500);

digitallWrite(4, LOW);

digitallWrite(3, HIGH);

delay(500);

digitalWrite(3, LOW);

// the loop() will now loop around and start from the top again

In void setup() at @, the digital I/O pins are set to outputs, because
we want them to send current to the LEDs on demand. We specify when to
turn on each LED using the digitalWrite() function in the void loop() @ sec-
tion of the sketch.

The Schematic

Now let’s build the circuit. Circuit layout can be described in several ways.
For the first few projects in this book, we’ll use physical layout diagrams
similar to the one shown in Figure 3-13.

By comparing the wiring diagram to the functions in the sketch,
you can begin to make sense of the circuit. For example, when we use
digitalWrite(2, HIGH), a high voltage of 5 V flows from digital pin 2, through
the current-limiting resistor, through the LED via the anode and then the
cathode, and finally back to the Arduino’s GND socket to complete the cir-
cuit. Then, when we use digitalWrite(2, LOW), the current stops and the LED
turns off.
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Figure 3-13: Circuit layout for Project 1

Running the Sketch

Now connect your Arduino and upload the sketch. After a second or two,
the LEDs should blink from left to right and then back again. Success is a
wonderful thing—embrace it!

If nothing happens, however, then immediately remove the USB cable
from the Arduino and check that you typed the sketch correctly. If you find
an error, fix it and upload your sketch again. If your sketch matches exactly
and the LEDs still don’t blink, check your wiring on the breadboard.

You now know how to make an LED blink with your Arduino, but
this sketch is somewhat inefficient. For example, if you wanted to mod-
ify this sketch to make the LEDs cycle more quickly, you would need to
alter each delay(500). There is a better way.

Using Variables

In computer programs, we use variables to store data. For example, in
the sketch for Project 1, we used the function delay(500) to keep the LEDs
turned on.
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The problem with the sketch as written is that it’s not very flexible. If we
want to make a change to the delay time, then we have to change each entry
manually. To address this problem, we’ll create a variable to represent the
value for the delay() function.

Enter the following line in the Project 1 sketch above the void setup()
function and just after the initial comment:

int d = 250;

This assigns the number 250 to a variable called d.

Next, change every 500 in the sketch to a d. Now when the sketch runs,
the Arduino will use the value in d for the delay() functions. When you
upload the sketch after making these changes, the LEDs will turn on and
off at a much faster rate, as the delay value is much smaller at the 250 value.

int indicates that the variable contains an integer—a whole number
between —-32,768 and 32,767. Simply put, any integer value has no fraction
or decimal places. Now, to alter the delay, simply change the variable dec-
laration at the start of the sketch. For example, entering 100 for the delay
would speed things up even more:

int d = 100;

Experiment with the sketch, perhaps altering the delays and the
sequence of HIGH and LOW. Have some fun with it. Don’t disassemble the cir-
cuit yet, though; we’ll continue to use it with more projects in this chapter.

Project #2: Repeating with for Loops

Chapter 3

When designing a sketch, you’ll often repeat the same function. You could
simply copy and paste the function to duplicate it in a sketch, but that’s inef-
ficient and a waste of your Arduino’s program memory. Instead, you can
use for loops. The benefit of using a for loop is that you can determine how
many times the code inside the loop will repeat.

To see how a for loop works, enter the following code as a new sketch:

// Project 2 - Repeating with for Loops
int d = 100;

void setup()

pinMode(2, OUTPUT);

pinMode(3, OUTPUT);

pinMode(4, OUTPUT);

pinMode(5, OUTPUT);

pinMode(6, OUTPUT);
}

void loop()



for (inta=2;a<7; at+t)

digitalWrite(a, HIGH);
delay(d);
digitalWrite(a, LOW);
delay(d);

The for loop will repeat the code within the curly brackets beneath it
as long as some condition is true. Here, we have used a new integer vari-
able, a, which starts with the value 2. Every time the code is executed, the
a++ will add 1 to the value of a. The loop will continue in this fashion while
the value of a is less than 7 (the condition). Once it is equal to or greater
than 7, the Arduino moves on and continues with whatever code comes
after the for loop.

The number of loops that a for loop executes can also be set by count-
ing down from a higher number to a lower number. To demonstrate this,
add the following loop to the Project 2 sketch after the first for loop:

® for (inta=5;a>1; a--)
{
digitalhWrite(a, HIGH);
delay(d);
digitalWrite(a, LOW);
delay(d);

Here, the for loop at @ sets the value of a equal to 5 and then subtracts
1 after every loop due to the a--. The loop continues in this manner while
the value for a is greater than 1 (a > 1) and finishes once the value of a falls
to 1 or less than 1.

We have now re-created Project 1 using less code. Upload the sketch
and see for yourself!

Varying LED Brightness with Pulse-Width Modulation

Rather than just turning LEDs on and off rapidly using digitalWrite(), we
can define the level of brightness of an LED by adjusting the amount of
time between each LED’s on and off states using pulse-width modulation
(PWM). PWM can be used to create the illusion of an LED being on at dif-
ferent levels of brightness by turning the LED on and off rapidly, at around
500 cycles per second. The brightness we perceive is determined by the
amount of time the digital output pin is on versus the amount of time it is
off—that is, every time the LED is lit or unlit. Because our eyes can’t see
flickers faster than 50 cycles per second, the LED appears to have a con-
stant brightness.
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The greater the duty cycle (the longer the pin is on compared to off in
each cycle), the greater the perceived brightness of the LED connected to
the digital output pin.

Figure 3-14 shows various PWM duty cycles. The filled-in gray areas rep-
resent the amount of time that the light is on. As you can see, the amount
of time per cycle that the light is on increases with the duty cycle.

5V

100% duty cycle
ov
5V

60% duty cycle
ov
5V

40% duty cycle
ov
5V

20% duty cycle
ov

Figure 3-14: Various PWM duty cycles

Only digital pins 3, 5, 6, 9, 10, and 11 on a regular Arduino board can
be used for PWM. They are marked on the Arduino board with a tilde (~),
as shown in Figure 3-15.
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Figure 3-15: The PWM pins are marked with a tilde (~).

To create a PWM signal, we use the function analoghrite(x, y), where x is
the digital pin and y is a value for the duty cycle, between 0 and 255, where
0 indicates a 0 percent duty cycle and 255 indicates 100 percent duty cycle.



Now let’s try this with our circuit from Project 2. Enter the following sketch
into the IDE and upload it to the Arduino:

// Project 3 - Demonstrating PWM
int d = 5;
void setup()

pinMode(3, OUTPUT); // LED control pin is 3, a PWM capable pin
}

void loop()

for (int a =0 ; a < 256 ; a++ )

{
analoghrite(3, a);
delay(d);
}
for (int a = 255 ; a>=0; a-- )
{
analoghrite(3, a);
delay(d);
}
delay(200);

The LED on digital pin 3 will exhibit a “breathing effect” as the
duty cycle increases and decreases. In other words, the LED will turn on,
increasing in brightness until fully lit, and then reverse. Experiment with
the sketch and circuit. For example, make five LEDs breathe at once, or
have them do so sequentially.

More Electric Components

WARNING

You'll usually find it easy to plan on having a digital output control do
something without taking into account how much current the control really
needs to get the job done. As you create your project, remember that each
digital output pin on the Arduino Uno can offer a maximum of 40 mA of
current per pin and 200 mA total for all pins. Three electronic hardware
components can help you increase the current-handling ability of the
Arduino, however, and are discussed next.

If you attempt to exceed 40 mA on a single pin, or 200 mA total, then you risk per-
manently damaging the microcontroller integrated circuit (IC).
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NOTE

Chapter 3

The Transistor

Almost everyone has heard of a transistor, but most people don’t really
understand how it works. In the spirit of brevity, I will keep the explana-
tion as simple as possible. A transistor can turn on or off the flow of a much
larger current than the Arduino Uno can handle. We can, however, safely
control a transistor using an Arduino digital output pin. A popular example
is the BC548, shown in Figure 3-16.
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Figure 3-16: A typical transistor: the BC548

Similar to the LED, the transistor’s pins have a unique function and
need to be connected in the proper orientation. With the flat front of the
transistor facing you (as shown on the left of Figure 3-16), the pins on the
BCb548 are called (from left to right) collector, base, and emitter. (Note that
this pin order, or pinout, is for the BC548 transistor; other transistors may
be oriented differently.) When a small current is applied to the base, such
as from an Arduino digital I/O pin, the larger current we want to switch
enters through the collector; then it is combined with the small current
from the base, and then it flows out via the emitter. When the small control
current at the base is turned off, no current can flow through the transistor.

The BC548 can switch up to 100 mA of current at a maximum of
30 V—much more than the Arduino’s digital output. In projects later in
the book, we will use this in other transistors, and at that time, you’ll read
about transistors in more detail.

Always pay attention to the pin order for your particular transistor, because each
transistor can have its own orientation.

The Rectifier Diode

The diodeis a very simple yet useful component that allows current to
flow in one direction only. It looks a lot like a resistor, as you can see in
Figure 3-17.
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Figure 3-17: A IN4004-type rectifier diode

The projects in this book will use the 1N4004-type rectifier diode.
Current flows into the diode via the anode and out through the cathode,
which is marked with the ring around the diode’s body. These diodes can
protect parts of the circuit against reverse current flow, but there is a price
to pay: diodes also cause a drop in the voltage of around 0.7 V. The 1N4004
diode is rated to handle 1 A and 400 V, much higher than we will be using.
It’s a tough, common, and low-cost diode.

The Relay

Relays are used for the same reason as transistors—to control a much larger
current and voltage. A relay has the advantage of being electrically isolated
from the control circuit, which allows the Arduino to switch very large cur-
rents and voltages. Isolation is sometimes necessary to protect circuits from
these 